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Getting Started

To get started, make sure that you have installed Adobe InDesign version CS4, CS5 or CS5.5. You can download 
and install the Kindle Plugin for Adobe InDesign® from the Kindle Publishing Programs webpage. For detailed 
instructions about system requirements and installation steps, refer to the Help and Release Notes.

It is recommended that you install the latest version of Kindle Previewer which is also available at the Kindle Pub-
lishing Programs webpage. Kindle Previewer is a tool that emulates how books display on Kindle devices and ap-
plications. Kindle Previewer makes it easy to preview the layout of a book and make sure its text displays properly 
for any orientation or font size.

It is recommended that while reading this document, you should refer to both the PDF and Kindle versions simul-
taneously so that the differences in formatting and layout between the two can be easily observed.

Formatting Guidelines

The first thing that you must bear in mind while creating Kindle books with Adobe InDesign is the difference be-
tween layouts of the two formats. Adobe PDF and such formats that are usually used for printing books are fixed 
layout formats which means that the text, images and other content is placed at specific locations on a page. Each 
page also has a specific fixed size which ensures that after printing, the book will appear exactly as it does on your 
computer screen.

Kindle books on the other hand have a reflowable layout which makes them agnostic of the screen size on which 
they will be read. This ensures better reader experience across various devices and font sizes. Because of the reflow-
able nature of the content, pages in the traditional sense are not imposed upon Kindle books similar to the way an 
HTML page cannot be divided into constituent pages. So while you may see some content on different pages in an 
InDesign document, it may or may not appear so on a Kindle.

Text Guidelines

Normal Text

You should not use any special formatting such as non-default font size, bold or italicized style or im-
posed font color or background color for the normal text in a Kindle book. Such behavior tends to be reported by 
Kindle users as poor experience since it overrides the users’ default reading settings. You can still use such styling 
for selected parts of the text.

Text Effects

A number of popular text effects available in Adobe InDesign are supported in Kindle books. Some of them 
are as follows:

1. Bold
2. Italics
3. Underline
4. Strikethrough
5. Superscript
6. Subscript

http://www.amazon.com/kindlepublishing/
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The following effects are not supported:

1. ALL CAPS
2. All small caps
3. Semibold
4. Medium italic and italic appear similar
5. Vertical scaling
6. Horizontal scaling
7. Baseline shift
8. Skewing
9. Background color
10. Custom fonts

Font color will only be supported on Kindle applications for various devices such as Kindle for PC, Kindle for 
Mac, Kindle for iPad, Kindle for Android etc.

Paragraph Formatting

It is preferable to use different paragraph styles for different blocks of content based on the logical organization 
of the document. You may apply different formatting to these paragraph styles to ensure that the content appears 
as intended. Supported paragraph style formatting options include:

1. Left indent
2. First line indent
3. Space before (above)
4. Space after (below)
5. Font size and style
6. Alignment

Under alignment, the options left, right, center and justify are supported. Justify alignment defaults to last 
line left aligned as do all other variations of justify alignment such as right justify, center justify and full justify. 

The align towards spine and align away from spine options default to left and right alignment respectively.

Due to the reflowable layout, any absolute spacing between two blocks of content will be ignored. You can con-
trol the spacing between two paragraphs with the space before and space after options, as demonstrated here. 
Spacing between this and the above paragraph has been increased by using both before and after spacing. 
 
 
 
 
 
 

You can also increase the spacing between content by inserting forced line break characters as inserted before 
this paragraph. Each line break character will add an HTML newline tag during conversion.



Page Breaks

You can insert an explicit page break using the page break character. Inserting an even or odd page break char-
acter will also have the same effect. However, inserting multiple page breaks one after the other will still count as 
inserting a single page break.

You can also set up a paragraph style so that a page break is always inserted before the paragraph. A possible 
use of this option is in the case of chapter titles where you want each chapter to start on a new page. To set this up, 
navigate to the Keep Options page in the paragraph style dialog and select the Start Paragraph On Next Page op-
tion from the drop down list. Applying this paragraph style to the chapter title will ensure that each chapter starts 
on a new page.

White Space Characters

If you need to insert multiple consecutive space characters, you need to use the Non-breaking Space character 
from the Type menu. Typing space multiple times with the spacebar or using the tab character will only result in a 
single space character. You should not use unicode format characters.

Monospace Font

Apart from the default, Kindle also supports a monospace font which can be used by changing your text font 
to Courier. Below is an example piece of code formatted with the monospace font.

#include <iostream>
int main()
{
    std::cout << “Hello World!” << std::endl;
}

You can use the monospace font along with the non-breaking space character to ensure precise rendering of 
particular content such as code blocks.

Conditional Text

You can use the conditional text option in certain scenarios where you need two versions of some text with 
minor variations while the majority of the content remains the same. The sentence below gives an example of the 
use of conditional text. Refer to the InDesign file for the condition.

The Explorer is used to manage your files on Windows.

You can invoke the conditional text dialog from the Window menu under Type & Tables. You can create vari-
ous conditions and then tag the appropriate text with those conditions. Toggle the visibility of one or more condi-
tions to display your text correctly.

Text variables are not supported by the plugin as of now.

Special Characters

You must use special characters judiciously and with caution to avoid any conversion issues. Many special 
characters provided within Adobe InDesign such as • © … ¶ ® § ™ are supported in the text of the document. For 
the full list of supported characters, refer to the Kindle Charset Support section in the Amazon Kindle Publishing 
Guidelines.

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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However, you should avoid certain special characters in the Book Title or the Table of Contents title, which are 
entered in the Kindle Export Options dialog. You may use all the printable ASCII characters, which includes all the 
characters you can type using a standard PC or Mac keyboard. You should not use any other Unicode characters 
such as © or ® in the Book or TOC title.

You must exercise additional caution in the case of file and folder names. As far as possible, avoid any special 
characters, especially / \ : * ? “ # < > ~ % | in the names of files and folders. These include

1. Source InDesign document (INDD) or InDesign Book (INDB) file
2. All the individual InDesign documents included in an InDesign Book
3. Target Kindle (MOBI) file
4. Cover image file
5. Folder path containing the source files
6. Folder path containing the target file
7. Folder path containing cover image file

The plugin attempts to validate numerous inputs to filter out potentially problematic special characters. How-
ever, not all scenarios can be covered and so you may occasionally get a warning or error message during conver-
sion. Due to operating system limitations, these errors may sometimes get misinterpreted as being caused by lack 
of disk space or write permissions. In such cases, verify that you do not have any special characters in the above 
mentioned locations and try converting the document again.

Multiple Columns and Tables

Any content that appears in a multiple column lay-
out will be converted to single column layout by the 
plugin. This includes text and images as well. If you 
face any issues with the conversion of multicolumnar 
content, you should try to verify the ordering of the 
content in the columns. If the issues aren’t resolved, 
you can try to manually change the content layout to 
a single column and convert again. Although tables 

can be used to split content into multiple columns, it is 
not recommended in the case of Kindle books. Tables 
should only be used to display tabular data. If a table 
contains too many columns or too much text in a col-
umn, it might make the table significantly larger than 
the screen forcing the user to pan the table repeatedly 
leading to a poor reader experience.

Recommended Dietary Allowance of Vitamin C
Adults (>19 years):
Males 90 mg
Females 75 mg
Infants / children:
0-6 months 40 mg
7-12 months 50 mg
1-3 years 15 mg
4-8 years 25 mg
9-13 years 45 mg
14-18 years (males) 75 mg
14-18 years (females) 65 mg



The Kindle format does not support nested tables. If you have a complex table with nested rows or columns or 
which uses very specific formatting, consider converting the table to an image. However, the limitation of using 
an image is that the user will not be able to pan across an image as it will be rendered on a single screen. In case of 
larger images with larger tables, you can split the images so that the contents of the table are legible. Refer to the 
Table Guidelines section of the Amazon Kindle Publishing Guidelines for more instructions on rendering tables.

Hyperlink Guidelines

External Hyperlinks

You can add links to external web pages from your documents by selecting some text and creating a new hyper-
link to the required URL. Hyperlinks will turn up as underlined clickable text in the converted file. On supported 
Kindle devices, clicking a hyperlink will bring up the web browser which will attempt to load the link provided 
there is an internet connection. On other reading applications such as Kindle for PC, Kindle for iPad etc., hyper-
links will open in the devices’ default web browser.

Cross-References

You can also add cross-references to locations within the same document. For instance, the following link adds 
a cross-reference to the beginning of the Text Guidelines section. To insert a cross-reference, you must first add a 
hyperlink destination of type Text Anchor to the location where you want to link to. Now you can insert a cross-
reference at the location that you want to link from and select the appropriate Text Anchor as the destination.

Footnotes

You can insert footnotes1 simply by clicking Insert Footnotes from the Type menu. Positioning of the footnote 
in the converted file can be customized according to your requirements. By default, the plugin will attempt to posi-
tion footnotes before a forced page break. If you have set up a paragraph style to start on a new page as described 
above, footnotes will also be inserted at the end of the previous section before the page break.

You can change this default behavior in a couple of ways. The first way is to insert footnotes in-place in which 
case, the footnotes will be inserted at exactly the same place as they appear in the InDesign document. So for in-
stance, the footnote in the previous paragraph will appear between the previous and this paragraph since that is 
the order of the flow of text in the document.

The other option is to insert all the footnotes at the end of the book. You should use this option if you have 
trouble getting the footnotes to appear in appropriate locations or if the footnotes interrupt the flow of text in the 
book. In this case, all the footnotes will collected together and inserted at the absolute end of the book. If you are 
converting from InDesign books (INDB), the footnotes from all the individual InDesign documents (INDD) will 
be aggregated and appended to the end of the book.

Note that the numbering style of the footnotes as specified in the Document Footnote Options will be ignored 
by the plugin. Any special characters or symbols used to mark footnotes will also be ignored. Instead, numbering 
of the footnotes will always start from 1 and will be reset every time footnotes are inserted at a new location. Most 
of the text styling within the footnotes will be retained in the converted file.

1 This is an example of a footnote. Formatting is preserved within the footnote.

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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List Guidelines

You can use both bulleted and numbered lists to represent enumerated data. Lists may be created in an ad hoc 
manner or by applying the List Style option in paragraph styles. The list format of a numbered list or use of any 
symbol as the bullet character of a bulleted list will be ignored and replaced by normal numbering and bullet re-
spectively.

The numbering of lists will be picked up exactly as it is in the InDesign document. So you must ensure that all 
list items are correctly numbered. If your list is going to span multiple paragraphs, pages or documents, it is advis-
able that you create a new list from the Define Lists dialog under the Type menu. Now you can associate a list with 
the appropriate list item so that the numbering remains consistent.

1. Level 1
1. Level 2

1. Level 3
2. Level 2

2. Level 1

You can also have nested lists as displayed above by adjusting the level of a particular list.

Table of Contents Guidelines

The Kindle Plugin for Adobe Indesign now provides two options for adding a Table of Contents. You can either 
define and include an InDesign TOC or you can manually create a cross-referenced TOC and then link to it. Both 
the options are described below:

Including InDesign TOC

Creating a table of contents for Kindle books follows similar steps as creating a table of contents for InDesign 
documents. First you need to create a set of paragraph styles that will be applied to the text making up the TOC 
entries. Each level of TOC entries will have one or more paragraph styles associated with it. After applying the 
paragraph styles to section headings, you need to create a TOC style and include all the relevant paragraph styles. 
You can use the Table of Contents Styles dialog under the Layout menu to create TOC styles and define the level 
hierarchy for the TOC entries.

Once you define a TOC style, you do not actually need to create and place the TOC within the InDesign docu-
ment. When you choose a TOC style in the Kindle Export Options dialog, the plugin will create a TOC with all 
the entries that you intended to include and place the TOC at the beginning of the converted file. In the case of 
InDesign documents (INDD), you can specify another location for the TOC by creating and placing the TOC in 
the InDesign document. However, this option is not available for InDesign books (INDB) where the TOC will 
always appear at the beginning of the book.

You can refer to the source of this document for an example of the TOC conversion process. The table of con-
tents style TOC Style is comprised of three paragraph styles - Heading 1, Heading 2 and Heading 3 - at the first, 
second and third level respectively. Simply doing this and specifying TOC Style during export will add a TOC at 
the beginning of the book. Since we want more control over the location of the TOC, we create a TOC in the In-
Design file and place it after the title page and just before the contents start. This ensures that the TOC appears at 
the same position in the flow of the book.



If you place a TOC in the InDesign document, only the location within the content flow will be used during 
conversion. The actual text of the TOC along with any formatting etc. will be ignored. Instead, the text to which the 
TOC paragraph styles have been applied will be used to create the TOC. You can specify a title for the TOC in the 
Kindle Export Options dialog. You also have the option of choosing from among four defined formatting options:

1. Flat layout means that all the TOC entries irrespective of the level will appear one below the other without 
any differentiating indentation.
2. Indented format will render the TOC entries in such a way that the indentation is proportional to the level 
of the TOC entry.
3. Numbered list will create a TOC in the form of a numbered list nested according to the levels.
4. Bulleted list will similarly create a bulleted list of TOC entries nested according to the corresponding levels.

In the case of InDesign books (INDB), you must ensure that the paragraph styles that you have used for the 
TOC entries text are also copied over to the Style Source document.

Linking custom TOC

If you are not satisfied with the quality of the TOC created with InDesign or if you would like to add some 
custom styling to the TOC, you also have the option to manually create a TOC and then link it from the export 
options dialog. You will need to manually create all the table of contents entries and then link each entry to the ap-
propriate location by cross-referencing. Finally, add a text anchor just before the heading of your TOC. The export 
options dialog will list all the text anchors in the document from which you can then choose the anchor which 
corresponds to your table of contents. In case of InDesign books (INDB), all the included documents will be listed 
and all the text anchors will be displayed for each file.

Note that you should not link to an InDesign TOC created using an InDesign TOC style and placed in the 
document in this manner. Also, note that NCX view will unavailable for books exported by linking a manually 
created TOC.

To see an example of a table of contents linked in this way, refer to the source of this document. In the condi-
tional text dialog, you can find one condition each for an InDesign TOC placed in the document and for a manu-
ally created and cross-referenced TOC. You can toggle between visibility of the two conditions to view either of 
the two tables of contents. In the manually created TOC, a text anchor named “Table of Contents” has been added. 
While exporting the document, you can choose to link a TOC and then select this text anchor to export the manu-
ally created TOC.

Image Guidelines

The Kindle platform supports GIF, BMP, JPEG, PNG images in your content. Vector graphics are not supported 
and should be converted to raster graphics using one of the supported image formats. The size limit for images is 
127KB. Below this limit, all images will be exported unaltered while above this limit, images will be automatically 
optimized to be under the size limit during conversion.



You can also take advantage of the optimization options that InDesign provides for images. In the Kindle Ex-
port Options dialog, you can choose to export either the original embedded images or the versions optimized by 
InDesign based on various parameters, as described below referenced from Adobe InDesign Help.

1. Formatted Preserves InDesign formatting, such as rotation or scale, as much as possible for web images.

2. Image Conversion Lets you choose whether the optimized images in your document are converted to GIF 
or JPEG. Choose Automatic to let InDesign decide which format to use in each instance.

3. GIF Options (Palette) Lets you control how InDesign handles colors when optimizing GIF files. The GIF 
format uses a limited color palette, which cannot exceed 256 colors. Choose Adaptive to create a palette using a 
representative sample of colors in the graphic without any dithering (mixing of small spots of colors to simulate 
additional colors). Choose Web to create a palette of web-safe colors that are a subset of Windows and Mac OS 
system colors. Choose System (Win) or System (Mac) to create a palette using the built-in system color palette. 
This choice may cause unexpected results. Select Interlace to display a slowly loaded image gradually by fill-
ing in missing lines. If this option is not select, an image looks fuzzy and gradually becomes clear as the image 
reaches full resolution.

4. JPEG Options (Image Quality) Determines the trade-off between compression (for smaller file sizes) and 
image quality for each JPEG image created. Low produces the smallest file and lowest image quality.

5. JPEG Options (Format Method) Determines how quickly JPEG graphics display when the file containing 
the image is opened on the web. Choose Progressive to make the JPEG images display gradually and in increas-
ing detail as they are downloaded. (Files created with this option are slightly larger and require more RAM 
for viewing.) Choose Baseline to make each JPEG file display only after it has been completely downloaded; a 
placeholder appears in its place until the file displays.

The above options will be enabled if you choose to export optimized images. You can leave these parameters to 
their default values for a reasonable balance between image quality and file size or you can choose to tweak them 
to suit your requirements.

You should note that images may be further optimized by kindlegen during conversion even if you have speci-
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fied an optimized format in the Kindle Export Options dialog. It is recommended that you always use the best 
quality images available, preferably in 300 dpi or 300 ppi resolution, and then let kindlegen optimize the images. 
Also, include color images wherever available to future proof your images and take advantage of the color displays 
on Kindle applications for other devices such as PC or iPad.

For images containing a lot of text, using the GIF format is recommended so that the sharpness and legibility 
of the text is retained. Since an image is always displayed completely on the screen, image resolution should be 
constrained to a maximum of 500x600 so that the image is not scaled, making it hard to read. Minimum font size 
should be such that a lower-case “a” is atleast 6 pixels tall. You can reduce the number of colors used in an image 
to optimize it’s size or split the image horizontally to keep it under the size limit. It is highly recommended that 
automatic optimization by kindlegen be avoided in case of images containing text.

You can also insert images inline  with the text as displayed here. An 
image inserted inline with the text should not be considerably taller that the 
text lest it increases the spacing between consecutive lines. Images placed as 
floating objects outside a text box, like this image of a stack of books, may 
not appear to follow the same flow of content in the converted file. This is 
because the plugin processes blocks of content one at a time and a floating 
image is processed as a separate block than the text that surrounds it.

All Kindle books are required to have a cover image. You can specify a cover image in the Kindle Export Op-
tions dialog. The preferred format for the cover is a JPEG image of 600 x 800 pixels. Cover images less than 500 
pixels on the smaller side stand to be rejected. The content of your cover image should not infringe any other pub-
lisher’s or artist’s copyrights and should not mention any pricing or promotional details.

For more information on image optimization techniques, refer to the Image Guidelines section of Amazon 
Kindle Publishing Guidelines.

Metadata Guidelines

The Kindle Plugin for Adobe InDesign® allows you to add certain metadata information to the converted file. It 
extracts any metadata that you have added to the InDesign file and prefills this information in the Metadata panel 
of the export options dialog. In case of InDesign books (INDB), the information is retrieved from the File Info of 
the style source document. The follow metadata are supported as of now:

1. Book Title: The title should match the content from the hardcover or paperback version and should not 
contain any detailed description of the book.
2. Author: Multiple authors should be separated by a semicolon. The convention to be followed for naming 
the author is
[Surname] [Suffix], [Given Name] [Initial]
For example: “Buckley Jr., William F.”

3. Publisher
4. Publication Date: The publication date is added to the exported file only if the publication year has been 
specified. Further, the date is added only if the month has been specified.
5. Description: It should describe the exact content being published in the Kindle edition and should not 
mention any pricing details. You can add a new line to the description by pressing Ctrl+Enter.

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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General Guidelines

This section documents general tips for using the plugin that do not fall under any specific category.

1. Close Adobe InDesign before you install or uninstall the plugin. Crucial files needed by the plugin may not 
get copied correctly if you install the plugin while InDesign is running. Similarly, uninstalling the plugin while 
Indesign is running may leave behind certain artifacts leading to an incomplete removal of the plugin.

2. Avoid installation or uninstallation of the plugin over the network. It is recommended that you download 
the installer and run it from your local machine.

3. Also avoid conversion of documents located on a network share. Network latencies can significantly in-
crease the conversion time, especially for large books. An intermittent network outage can also lead to a failed 
conversion. Instead, copy the files to your local machine before attempting to convert them.

4. Embedded objects of certain formats like PDF or PS are not supported by kindlegen and will cause an er-
ror during conversion. However, the file may convert successfully in some cases if you select the Optimized 
Images option in Kindle Export Options dialog. This is because InDesign will try and insert the thumbnails of 
the embedded objects instead of the original files.

5. The kindlegen output is displayed in a dialog after the conversion process completes, either unsuccessfully 
or with warnings. The warning icon indicates that the conversion was successful but kindlegen threw some 
warning(s) due to some constraint not being respected. The most common reason for this is not specifying a 
cover image or specifying an image with non-recommended proportions. In case of an error, you can look at 
the output to deduce the reason for failure and try again.

6. As of now, embedding of audio or video files is not supported by the plugin.

7. If you need to edit the source of a converted mobi file, you need to first extract the file using an archiving 
tool such 7-Zip. On a Mac, you can simply change the extension of the file to zip and then extract it using the 
default archiver. A directory containing the source files will be created. You can find all the HTML, CSS, OPF 
and NCX files along with the embedded images in the folder named OEBPS. You can now edit any of the files 
and create a new mobi provided you don’t break the syntax of any file and follow the constraints laid down in 
the Amazon Kindle Publishing Guidelines. This is not recommended unless you know HTML, XML and CSS 
and are comfortable using command line tools. You can convert the edited files by invoking kindlegen on the 
OPF file.

8. If you have any feedback, complaints or suggestions for the plugin, write back to us at kindle-publishing-
tools@amazon.com. Alternately, you can click the Send Feedback link on the Kindle Export Options dialog. 
It will open a new mail dialog in your default email client and fill up the To and Subject fields. It will also add 
some debug information about your system, specifically the OS name and version, version of Adobe InDesign, 
plugin version and locale. No personal information will be collected.

~~~ end ~~~
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